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1 Цель работы 
Изучение инструментальных средств и интегрированной среды разработки про-

граммного обеспечения для микроконтроллеров, а также изучение по методу “Быстрый 
старт” этапов технологии разработки и отладки программ. 

2 Содержание работы 
1. Введение в Keil uVision [1]. 
2. Быстрый старт. 

3 Инструментальные средства Keil Software 
Инструментальные средства Keil Software включают C и EC (Embedded C) компиля-

торы, ассемблеры, отладчики и симуляторы, интегрированные среды разработки и оце-
ночные платы. Keil Software разрабатывает и производит средства разработки для сле-
дующих промышленных стандартов: 

• Infineon C16x/XC16x и ST-Micro ST10/Super10  
• ARM7 и ARM7TDMI  
• 8051 Classic и Extended  
• Philips LPC  
• 251 Atmel, Intel и Sanyo  

Keil Software поддерживает все разновидности вышеуказанных микроконтроллеров и 
все стадии разработки приложения: создание исходного файла на C / EC или ассемблере, 
трансляцию, исправление ошибок, линкование объектных файлов, тестирование приложе-
ния. 

В данном курсе лабораторных работ мы будем использовать средства разработки для 
микроконтроллеров 8051. 

3.1 Средства разработки микроконтроллерного семейства MCS51 (8051 
Development tools) 
Keil software поставляет следующие средства разработки: 

• A51 Assembler Kit содержит A51 Assembler, 8051 Utilities и µVision IDE  
• CA51 Compiler/Assembler Kit разработан для проектов с классическими МК 8051, 

содержит все компоненты A51 плюс C Compiler Cx51 и Code Banking Linker, кото-
рый поддерживает до 32 банков кода (code banks), что позволяет выходить за пре-
делы адресного пространства 64 KByte  

• DK51 Developers Kit включает все компоненты CA51 плюс µVision Debugger, под-
держивающий полную симуляцию устройств и target monitor.  

• PK51 Professional Developers Kit содержит все компоненты DK51 плюс PK51 
Extentions: поддержка расширенной памяти (до 16MB), variable banking, ОС реаль-
ного времени RtxTiny2, оптимизированное линкование, внутрисхемный отладчик 
ISD51, поддержку Philips MX и contiguous mode Dallas 390. 

Keil Software поддерживает все стадии разработки приложения: создание исходного 
файла на С или Ассемблере, трансляцию, исправление ошибок, линкование объектных 
файлов, тестирование приложения. 

Средства разработки (CA51, DK51, PK51) для классических 8051 микроконтроллеров 
(с поддержкой до 32 банков по 64 Кб памяти программ) содержат: 

• C51 Compiler – компилятор С; 
• A51 Macro Assembler – макроассемблер; 
• BL51 Lincer/Locater – динамический загрузчик/компоновщик. 
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Средства разработки (CA51, DK51, PK51) для классических и расширенных 8051 
микроконтроллеров с поддержкой подкачки кода из расширенной памяти (xdata) до 16 Мб 
содержат: 

• С51 Compiler (with OMF2 Output) - компилятор С (с новым выходным фай-
ловым форматом); 

• AX51 Macro Assembler – макроассемблер с поддержкой Extended 8051; 
• LX51 Lincer/Locater – динамический загрузчик/компоновщик с поддержкой 

Extended 8051. 
Также в Keil Software входят дополнительные средства разработки: 

• Конвертер объектных файлов объектных файлов OC51; 
• Конвертер объектных и HEX-файлов OH51; 
• Менеджер библиотек LIB51; 
• Интегрированная среда разработки (IDE) Keil uVision; 
• Операционная система реального времени (Real-Time Operating System - 

RTX). 

3.2 Интегрированная среда разработки Keil uVision (uVision IDE) 
Простая в использовании интегрированная среда разработки (Integrated Development 

Environment) uVision IDE фирмы Keil позволяет непосредственно вызывать симулятор или 
внутрисхемный эмулятор и содержит богатый набор  инструментальных опций:  

• Device Database - интеллектуальная база данных; 
• Project Management - управление проектами; 
• Source Code Editor - интегрированный редактор; 
• Building Projects - автоматическая генерация проекта; 
• Integrated Utilities - средства, облегчающие создание проекта. 

База данных устройств (Device Database). 
 

База данных содержит де-
тальную информацию о всех 
устройствах, поддерживаемых 
инструментальными средствами 
Keil. База данных поддерживает 
параметрический поиск МК, 
удовлетворяющего специфиче-
ским требованиям (см. рис. ). 
При выборе устройства из базы 
данных все требуемые опции в 
проекте под управлением 
uVision устанавливаются авто-
матически. Device Database со-
держит подробное описание 
конфигурирования и ссылки на 
другие источники информации 
(data sheets, оценочные платы, 

эмуляторы). 

1

Рис. 1. База данных устройств 

Управление проектом (Project Management) 
Программный проект состоит из большого числа связанных друг с другом исходных 

файлов, которые часто обрабатываются индивидуально. Например, часть файлов подле-
жит С-компиляции, другие следует ассемблировать, а третьи требуют некоторой специ-
альной обработки пользователем. Здесь на помощь приходит Менеджер проекта, который 
дает разработчику методику создания проекта из исходных файлов, различных опций раз-
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работки и директорий. Проект в uVision может сгенерировать одну или несколько target-
программ, каждая из которых компилируется по индивидуальным правилам. На основе 
исходных файлов создаются target-программы, объединенные в группы Groups. При этом 
достигается простая интеграция различных исходных файлов в проект. 

Редактор исходного кода (Source Code Editor) 
Интегрированный в uVision редактор значительно облегчает подготовку исходного 

текста за счет многооконности, выделения синтаксиса цветом и исправления ошибок в 
режиме диалога. Редактор настраивается на конкретный проект и в соответствии со вку-
сами пользователя. Редактирование остается доступным и во время отладки программы. 
Это создает все условия для быстрого тестирования и корректировки Вашего приложения.  

Сборка проекта (Building Projects) 
uVision содержит встроенную утилиту make, которая используется для компиляции, 

ассемблирования и линкования программ. При нажатии на кнопку Build Target осуществ-
ляется компиляция исходного файла. Ассемблер и компилятор автоматически генерируют 
зависимости между файлами и добавляют их в проект. Благодаря этой информации вновь 
обрабатываются только те файлы, которые претерпели изменения или файлы, включаю-
щие измененные файлы. Во время компиляции и ассемблирования исходного файла, в ок-
не Output Window появляется статусная информация, сообщения об ошибках и предупре-
ждения (см. рис. 2). 
 

При двойном щелчке на сообщение об ошибке или на предупреждение происходит 
переход к редактированию файла (при этом uVision продолжает обработку исходного 
файла в фоновом режиме). Номера строк ошибок и предупреждений синхронизированы и 
соответствуют факту после внесения исправлений в исходный файл. Для получения 
справки о сообщении об ошибке следует выбрать сообщение и нажать клавишу F1. При 
глобальной оптимизации uVision неоднократно компилирует исходный файл для дости-
жения оптимального использования ресурсов микроконтроллера. 

Рис. 2. Окно Output Window 

Все параметры проекта сохраняются в специальном файле, который содержит список 
исходных файлов, командные строки компилятора, ассемблера, редактора, отладчика, си-
мулятора и утилиты make. При использовании этого файла компиляция и линковка проек-
та происходят по нажатию одной клавиши. 

Встроенные утилиты (Integrated Utilities) 
uVision содержит мощные средства, облегчающие создание проекта:  

• Source Browser - база данных программных символов для быстрой навигации по 
исходному файлу; 

• Find in Files - полный поиск во всех выделенных файлах; 
• Tools Menu - утилиты других фирм из uVision IDE; 
• SVCS - контроль версии программного обеспечения; 
• PC-Lint - анализ синтаксиса исходного кода; 
• Flash tool - утилиты загрузки flash-памяти; 
• Easy CASE - генерация кода при задании программы на уровне блок-схемы; 
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• DAvE - автоматическая генерация программ и драйверов для периферии МК In-
fineon. 

3.3 Компилятор Си Cx51 (C Compiler Keil Cx51) 
Новые возможности компилятора Cx51 (Cx51 Highlights): 

• Cx51 поддерживает все разновидности 8051 и обеспечивает доступ ко всем про-
граммным компонентам; 

• Быстрая 32-разрядная IEEE арифметика с плавающей точкой; 
• Cx51 поддерживает множественные указатели данных DPTR и дополнительные 

арифметические устройства; 
• Детальные предупреждения и сообщения об ошибках, проверка синтаксиса; 
• Cx51 осуществляет полную регистровую оптимизацию New Code Optimizations; 
• Доступ на С ко всем регистрам SFR, побитно адресуемым регистрам и отдельным 

битам Memory and SFRs; 
• Очень быстрые прерывания за счет reentrant функций Interrupt Functions; 
• Гибкие указатели областей памяти Flexible Pointers; 
• Модели и селекторы памяти Memory Models and Memory Selectors; 
• Эффективные механизмы memory banking и отладки - расширение адресного про-

странства за пределы 64 KB; 
• Оптимизация при линковании - инструкции AJMP и ACALL; 
• Поддержка отладочной информации для всех эмуляторов. 

Оптимизация кода (Code Optimizations) 
Cx51 поддерживает эффективные механизмы оптимизации, которые генерируют 

программы минимального размера: 
• Регистровая оптимизация Dynamic Register Allocation позволяет разместить в реги-

страх больше переменных, уменьшить размер кода (за счет уменьшения числа ко-
манд MOV) и сократить объем оверлейных данных; 

• Общая оптимизация кода Common Tail Optimization комбинирует идентичные 
фрагменты кода в специальных блоках и сокращает размер кода. 

Память и регистры специальных функций (Memory and SFRs) 
Компилятор Cx51 осуществляет прямое управление банками регистров и полное их 

использование, побитовую адресацию данных:  
• Для доступа к регистрам специального назначения и их отдельным битам исполь-

зуются ключевые слова sfr и sbit; 
• В соответствие переменной может быть назначен любой сегмент адресного про-

странства. С помощью ключевого слова _at_ переменные могут быть размещены по 
фиксированному адресу памяти. 

Функции обработки прерываний (Interrupt Functions) 
Cx51 осуществляет эффективное управление прерываниями при написании функций 

прерывания на С за счет малого времени вызова/возврата в/из прерывания и переключе-
ния регистровых банков. Cx51 поддерживает reentrant функции и код, не привязанный 
жестко к регистровым банкам, для генерации процедур прерывания и использования в 
многозадачных приложениях. Рекурсивные или повторно используемые функции опреде-
ляются с помощью ключевого слова reentrant. Функции, вызываемые многими задачами 
должны быть определены как reentrant. 

Гибкие указатели (Flexible Pointers) 
Линковщик поддерживает code banking, а uVision Debugger поддерживает тестирова-

ние программ размером до 16MB code и xdata. Cx51 имеет два типа указателей для раз-
личных областей памяти: 

• Основные указатели Generic pointers позволяют получить доступ ко всем областям 
памяти 8051, сохраняя информацию о типе памяти и адресе объекта в 3-х байтах; 
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• Специальные указатели Memory-specific pointers объявляются через тип памяти и 
указывают на определенную область памяти 8051. Поскольку для сохранения ин-
формации об объекте требуется всего 2 байта, такие указатели позволяют сгенери-
ровать более компактный код 
Модели и селекторы памяти (Memory Models and Memory Selectors) 

Модель памяти определяется с помощью default memory selector используемого для 
переменных. Однако всегда есть возможность вполне определенно специфицировать 
memory selector для любой переменной. Область размещения переменных и функций и 
время доступа к ним определяется моделью памяти. Выбор модели памяти зависит от тре-
буемого размера и физического размещения: Small - 128 байт, Compact - 256 байт, Large - 
64 Кбайт. Несколько типов селекторов позволяют осуществить эффективный доступ к 
различным областям памяти и сгенерировать компактный код (см. табл. 1). 
Табл. 1. Модели и селекторы памяти 
Селек-
тор 

Область памяти 

data 128 байт во встроенной RAM – непосредственная адресация 
bdata 16 байт во встроенном RAM - непосредственная битовая/байтовая адресация 
idata 256 байт во встроенном RAM - косвенная адресация 
pdata 256 байт в страничной внешней RAM 
xdata 64 Kбайт расширенной RAM 
code 64 Kбайт памяти программ 
far 16 Мбайт памяти data/const, размер объекта 64 Kбайт 

near 64 Kбайт непосредственно адресуемой памяти для 251 
huge 16 Мбайт косвенно адресуемой памяти, объект произвольного размера 
edata 96 байт расширенной побитно адресуемой памяти для 251 

 
В состав Cx51 входят два компилятора: C51.exe и CX51.exe. Более подробную ин-

формацию о компиляторах можно получить в руководстве пользователя [2]. Кроме этого, 
в техническом описании учебно-лабораторного стенда SDK-1-1 приведён перевод с анг-
лийского языка для компилятора С51.exe [3]. 

При работе в Keil uVision выбор компилятора (C51.exe или CX51.exe) происходит 
автоматически в зависимости от типа микропроцессора. 

3.4 Макроассемблер Ax51 
Ассемблер фирмы Keil Ax51 специально разработан для семейства микроконтролле-

ров 8051. Ассемблер в основном применяется при написании фрагментов программ, наи-
более критичных к скорости, размеру кода и возможностям аппаратного управления. В 
ассемблер включен макроязык, использование которого ускоряет разработку и экономит 
общее время проектирования. Макроязык позволяет также осуществлять доступ ко всем 
ресурсам микроконтроллеров с использованием символьных обозначений регистров. 

В состав Ax51 (аналогичным образом как и в Cx51) входят компиляторы: A51.exe и 
AX51.exe. При этом компилятор AX51.exe поддерживает расширенные типы микропро-
цессоров 8051. Более подробную информацию о компиляторе Ax51 можно получить в ру-
ководстве пользователя [4]. 

3.5 Отладчик (uVision Debugger) 
uVision Debugger фирмы Keil позволяет вести отладку исходных текстов программ, 

написанных на С и ассемблере или в смешанном формате, сохраняет историю трассиров-
ки и позволяет выбирать между симулятором, монитором и внутрисхемным эмулятором. 
В состав uVision Debugger входят: 
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• CPU & Peripheral Simulator - симулятор CPU и периферии; 
• Performance Analyzer & Code Coverage - анализаторы производительности и эффек-

тивности кода; 
• Target Monitor - отладочный монитор; 
• uVision Cx51 Target Debugger - интерфейс к отлаживаемому устройству через драй-

веры AGDI; 
• uVision C166/ST10 Target Debugger - поддержка начальной загрузки Bootstrap и ин-

терфейса OCDS/JTAG; 
• Breakpoints - точки останова; 
• Debug Function Scripts - C-подобный язык для записи функций; 
• Variables and Memory - просмотр областей памяти и  регистров. 

 
Симулятор центрального процессора и интегрированной периферии (CPU & 

Peripheral Simulator) 
uVision Simulator - чисто программный продукт, который осуществляет отладку в ис-

ходных кодах, симуляцию на уровне символов и отладку непосредственно на рабочей 
плате - target debugging. Моделируется вся система команд и все периферийные устройст-
ва. 

Для просмотра и изменений установок периферии служат специальные диалоговые 
окна. Симулятор полностью поддерживает периферийные устройства микроконтроллера 
посредством специальных драйверов xxx.DLL. 

Для симуляции аппаратной части МК 8051 Keil 
предлагает Advanced Generic Simulation Interface 
(AGSI). AGSI является спецификацией API, расширяю-
щей возможности симуляции с помощью диалоговых 
настроек. Кроме AGSI DLL от третьих фирм поддержи-
ваются распространенные МК: Philips 51MX, Dallas 
390, Analog Devices, Atmel, Mentor M8051EW. 

В распоряжение пользователя предоставляется 
ряд окон, отображающих состояния таймеров (см. рис. 

), портов, прерываний, сторожевого таймера, последо-
вательного порта, аналогово-цифрового преобразовате-
ля и т.д. Параметры этих устройств могут быть уста-
новлены и изменены в соответствии с контекстом при-
ложения. uVision Simulator позволяет проводить поша-
говую отладку программы, просматривая ее в окне 
Debug. Трассировщик запоминает команды и позволяет 
их просматривать в окне Trace. Изменение заранее за-
данных переменных отслеживает окно Watch. Последо-

вательность вызова процедур отображается в окне Call-Stack. 

3

 
Рис. 3. 

 
Анализатор производительности и эффективности кода (Performance Analyzer & 

Code Coverage) 
В uVision Debugger встроен анализатор производительности Performance Analyzer, 

который фиксирует время исполнения программных модулей. Задавая список модулей 
для анализа, пользователь получает диаграмму затрат времени на каждую часть програм-
мы (см. рис. 4). 

uVision Debugger позволяет также провести анализ эффективности кода Code 
Coverage, локализуя части программы, к которым редко происходит обращение, что по-
зволяет удалить ненужный код (см. рис. 5). 
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Рис. 4. 

 

Отладочный монитор (Target Monitor) 

 
 

Рис. 5. 

При отладке программ на плате в качестве интерфейса используется специально 
сконфигурированный отладочный монитор, загружаемый в ОЗУ с помощью встроенного 
начального загрузчика или прошиваемый в EPROM. Программа монитор обеспечивает 
прямой интерфейс для отладчика/симулятора и легко настраивается на любой микрокон-
троллер. При помощи монитора производится комплексная отладка приложения на плате. 
В остальном же отладка ничем не отличается от режима симуляции. Требования к ресур-
сам микроконтроллера со стороны монитора минимальны. 

Отладочный монитор Cx51 (uVision Cx51 Target Debugger) 
В uVision Debugger для Cx51 интерфейс к отлаживаемому устройству осуществляет-

ся через драйверы Advanced Generic Debugger Interface (AGDI). На сегодняшний день су-
ществуют следующие драйверы: 

• Monitor-51 - конфигурируемый монитор для отлаживаемого устройства, который 
прошивается в ROM устройства (поставляется со многими оценочными платами); 

• Monitor-390 - конфигурируемый монитор для Dallas contiguous mode; 
• ISD51 - внутрисхемный отладчик для стандартных МК 8051; 
• EPM900 - эмулятор/программатор для Philips LPC900; 
• SmartMX DBox - эмулятор для Philips SmartCards; 
• Некоторые из МК подключаются к uVision Debugger также с помощью драйверов 

AGDI: ChipCon CC1010, Cygnal 51Fxxx, Cypress USB, Infineon SLE66, SST Flash-
Flex51, Triscend E5; 
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• Драйверы uVision AGDI доступны также для многих эмуляторов. 
 

Точки останова при отладке (Breakpoints) 
 

uVision предлагает широкие возможности по заданию про-
стых и условных точек останова (см. рис. 6). Условием останова 
может быть или результат выражения или операция обращения к 
ячейке памяти/ переменной (чтение, запись, доступ). Для редак-
тирования и просмотра параметров контрольных точек служит 
окно Breakpoint. Точки останова могут остановить исполнение 
программы или запустить команду или сценарий отладчика. 
 
    
 Рис. 6. 
 

Язык функций отладки (Debug Function Scripts) 
 

Для автоматизации типовых операций, выполняемых 
при отладке, могут быть созданы специальные командные 
файлы. Для ввода этих команд служит окно Command или 
окно Toolbox (см. рис. 7). Кроме того uVision поддерживает 
C-подобный функциональный язык, позволяющий 
генерировать: 

• Встроенные функции типа printf, memset, rand и 
другие; 

• Сигнальные функции для моделирования аналоговых 
и цифровых входных/выходных сигналов CPU; 

 • Функции пользователя для расширения 
возможностей команд и повторяющихся операций.  

Рис. 7.  
 

Переменные и память (Variables and Memory) 
В распоряжении пользователя находятся окна для 

просмотра областей памяти Memory и состояний регистров 
Register. Например, с помощью окна Serial I/O (см. рис. 8) 
становиться возможной наглядная симуляция 
последовательного ввода/вывода. uVision предлагает не-
сколько путей для просмотра и изменения переменных и 
памяти: 

• Поместить указатель мышки над переменной, 
чтобы посмотреть ее значение; 

• Использовать окно Watch для просмотра и 
изменения локальных и определенных пользо-
вателем переменных; 

• Использовать окно Memory  для просмотра и  
редактирования до 4-х массивов памяти. 

  
  Рис. 8.  

Более подробную информацию о uVision можно узнать в руководстве пользователя 
[1]. 
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3.6 Многозадачное ядро реального времени (RtxTiny Real Time Kernel) 
Многозадачное ядро реального времени RtxTiny предназначено для разработки одно-

процессорных многозадачных систем и интегрирована в программный пакет PK51. 
RtxTiny - облегченная версия популярной операционной системы RTX51. RtxTiny имеет 
следующие свойства: 

• Поддержка множественных указателей DPTR и арифметических устройств; 
• Поддержка режимов одиночного кристалла и code banking; 
• Round robin (циклическое) и совместное переключение задач; 
• Управление задачами с функциями инициации и удаления; 
• События Timeout, Signal и Ready; 
• Поддержка прерываний от посылаемых сигналов. 
Более подробно о RTX51 можно узнать из руководства пользователя данной опера-

ционной системы [5]. 

3.7 Структура каталогов 
Структура каталогов, и в целом методика разработки приложений, в Keil аналогична 

как в программных продуктах Borland C++, Microsoft Visual C++ и т.д.  
На сервере Class FTF (диск L) средства разработки Keil Software установлены сле-

дующим образом: 
L:\Keil\C51\ASM Файлы ассемблерных определений SFR-регистров для разных 

процессоров и файлы исходных шаблонов; 
L:\Keil\C51\BIN Исполнимые файлы средств разработки для 8051; 
L:\Keil\C51\EXAMPLE Примеры приложений для 8051; 
L:\Keil\C51\RTX_TINY Файлы облегчённой версии операционной системы реального 

времени RTX51; 
L:\Keil\C51\INC Заголовочные файлы компилятора Си; 
L:\Keil\C51\LIB Файлы библиотек компилятора Си; 
L:\Keil\C51\UV2 Файлы интегрированной среды разработки uVision. 

В каталоге L:\Keil находится файл «Запуск Uv2.lnk» - ярлык для запуска интегриро-
ванной среды разработки uVision. Для удобства работы скопируйте этот ярлык на свой 
рабочий стол. 
 
 
 

Горюнов А.Г. Ливенцов С.Н. «Быстрый старт» 12



3.8 Цикл разработки приложения в Keil uVision (Software Development Cy-
cle) 
Цикл разработки приложения, при использовании средств разработки Keil Software, 

приблизительно состоит из следующих этапов: 
1. Создание проекта, выбор target-микроконтроллера из базы данных и настройка 

средств разработки. 
2. Создание исходных файлов на языке Си и (или) ассемблере. 
3. Сборка приложения с помощью менеджера проектов. 
4. Исправление ошибок в исходных файлах. 
5. Проверка приложения. 
Цикл разработки приложения для 8051 проиллюстрирован на блок-схеме (рис. ). 9

 

Элементы блок-схемы (см. рис. 9) уже рассмотрены в данной главе. Более подроб-
ную информацию можно получить из руководства пользователя [1]. 

 
Рис. 9. Цикл разработки приложения для 8051 в 

Keil Software 
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4 Быстрый старт 
“Быстрый старт” – это обычный приём разработчиков современных программных 

средств. Цель состоит в том, чтобы, не углубляясь пока в подробности, дать новичку или 
достаточно опытному пользователю первое представление о программном средстве, дать 
возможность быстро получить конкретный результат. Полное представление, знания и 
умения появятся позже в процессе работы и изучения справочных материалов. 

В качестве примера возьмём простейшую программу, с которой начинают изучение 
языков программирования многие поколения студентов. “Hello World” - программа анало-
гичная примеру из папки \C51\Examples\Hello\, которая выдаёт в последовательный порт 
(UART) микроконтроллера строку символов “Hello World” (“Привет Мир”). Весь исход-
ный текст программы содержится в файле hello.c: 

Пример 1. Исходный текст приложения “hello” 
/* --------------------------------------- 
Ваша первая программа для SDK-1-1 на основе MCS51 
------------------------------------------ */ 
#include <ADuC812.h> 
#include <stdio.h> 
 
// Подпрограмма работы с портами ПЛИС 
void WriteMax(unsigned char xdata *regnum, unsigned char val) 
{ 
#define MAXBASE 0x8; 
unsigned char oldDPP=DPP; 
 
DPP=MAXBASE; 
*regnum=val; 
DPP=oldDPP; 
} 
 
void main(void) 
{ 
unsigned char svet = 1; 
unsigned int pause; 
// ------- Инициализация UART ----------- 
TH1 = 0xFD; // Скорость 9600 бит/с 
TMOD = 0x20;// Таймер 1 в режиме autoreload 
TCON = 0x40;// Запуск таймера 1 
SCON = 0x50;// 8 bit UART, разрешение приема 
PCON &= 0x7F;// Отключение удвоения скорости 
TI = 1; // Требуется для работы с  
RI = 1;// stdio.h 
EA = 0;// Запрещение прерываний 
do 

{ 
printf ("Hello World\n");// вывод на терминал "Hello World" 
svet = svet<<1;// сдвиг влево 
if(svet==0) svet=1; 
WriteMax(0x7,svet);//вывод на светодиды  
for(pause=0;pause<=32000;pause++);// задержка 

} while(1); 
} 
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4.1 Запуск uVision IDE и создание нового проекта 
В каталоге L:\Keil находится файл «Запуск Uv2.lnk» - ярлык для запуска интегриро-

ванной среды разработки uVision. Для удобства работы скопируйте этот ярлык на свой 
рабочий стол, а затем запусти при помощи его среду разработки. 

Любая новая работа в uVision IDE, как и во всех современных компиляторах, начи-
нается с создания нового проекта. Файл проекта содержит имена всех исходных файлов, 
связанных с проектом, а также установки компиляции, трансляции и связывания файлов, 
чтобы генерировать выполняемую программу. 

Для создания нового проекта необходимо выполнить следующие действия: 
1. После запуска среды закрыть все существующие проекты (если таковые 

имеются), иначе могут возникнуть трудности на этапе отладки программы. Для этого в 
меню Project нажать Close project (см. рис. 10). 
 

2. Создать на своём диске U следующие папки: 
U:\MPT 
 U:\MPT\LAB1 
  U:\MPT\LAB1\Hello 
   например, при помощи Far – менеджера. 

 
 

Рис. 10. 

Желательно чтобы каждый проект находился в отдельной папке. 
3. Создать новый проект, для чего в меню Project выбрать New Project (см. рис. 

). Высветиться окно с просьбой сохранить проект (см. рис. 12). Проект сохраняете в за-
ранее подготовленную папку U:\MPT\LAB1\Hello. 
11

Если проект уже существует, то в том же меню (рис. 11) нажать Open Project, после 
чего в появившемся диалоговом окне выбрать нужный проект. 
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Рис. 11. 

 
 

 
 

Рис. 12. 
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После сохранения проекта высветиться диалоговое окно, в котором необходимо вы-
брать модификацию микроконтроллера. Необходимо выбрать Analog Device -> ADuC812 
(см. рис. 13). 

4. Настроить опции проекта, для чего нажать пункт меню Project -> Option for 
target и выставить параметры как показано на рис. 14. 

 
 

Рис. 13. 

 
 

Рис. 14. 
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На рис. 14 выделено следующее: 
1 – Частота резонатора. В SDK-1-1 установлен кварцевый резонатор на 11.0592 МГц. 
2 – Область внешней памяти программ. В SDK-1-1 доступно 56 Кб памяти про-
грамм/данных, если не используется подкачка кода (Code Banking). 
3 – Область внешней памяти данных. В SDK-1-1 младшие 8 Кб внешней ОЗУ доступны 
только для размещения данных. Будем в ней располагать переменные с типом xRAM. 

Далее выбираем закладку Output (см. рис. 15), в которой устанавливаем флажок Cre-
ate HEX File. 
 

В графе Name of Executable указывается имя создаваемого hex-файла, как правило, 
оно совпадает с именем проекта. 

 
 

Рис. 15. 

Информацию об установки остальных параметров проекта можно получить из руко-
водства пользователя [1]. В данном случае этих настроек достаточно. 
 

Горюнов А.Г. Ливенцов С.Н. «Быстрый старт» 18



4.2 Создание и добавление файла с исходным текстом, и его редактиро-
вание 
Теперь необходимо создать исходный файл hello.c. Для этого в меню File необходи-

мо нажать New (см. рис. 16), после чего сохранить его как hello.c в папку проекта исполь-
зуя меню File -> Save AS. 
 

 
 

Рис. 17. 

Далее необходимо файл hello.c добавить в проект следующим образом: 

 
 

Рис. 16. 

• Выделить курсором Source Group 1 в Project Window (см. рис. 17). 
• Правой кнопкой мыши вызвать меню и добавить файл в проект (см. рис. 18) 

 
 
 
 
 
 
 
 
 
 
 
 
 

  Рис. 18. 
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Для редактирования файла hello.c в окне Project Window левой кнопкой мыши щёлк-
ните по соответственному файлу (см. рис. 19). 

В файле hello.c необходимо набрать исходный текст примера 1. 

 
 

Рис. 20. 

Кроме файла исходного текста в проект необходимо добавить ассемблерный файл 
STARTSDK.A51, который находится в папке L:\Study\МПТ\SDK_1_1\EXAMPLE, это дора-
ботанный вариант стандартного STARTUP.A51 файла инициализации Си приложений спе-
циально для учебно-лабораторного стенда SDK-1-1. 

 
 

Рис. 19. 

4.3 Сборка проекта и отладка 
Откомпилировать проект, используя иконку Build Target или меню Project -> Build 

Target (см. рис. 20). 
Для отладки программы использовать меню Debug (см. рис. 21). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

  
  

Рис. 21.  
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Отладчик uVision Debug позволяет выполнять следующие инструкции: 
Step – выполнение текущей инструкции и переход на следующую; 
Go – выполнение программы с текущей инструкции; 
Break points – меню точек останова. 

Команды Step Over позволяют “шагать” по каждой строке исходного текста. Текущая 
команда высвечивается на каждом шаге. Step позволяет войти в вызываемую функцию, 
Step Over – перешагнуть через неё, не входя во внутрь (см. рис. 22). Перечисленные ко-
манды находятся в меню 1 (выделено на рис. 22), а указатель 2 – показывает какую сле-
дующую инструкцию будет выполнять отладчик. 
 

 

 
 

Рис. 22. 
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Отладчик uVision Debug позволят просматривать трассировку исходного текста на 
языке ассемблера. Для того чтобы включить данный режим необходимо использовать 
иконку Disassembly Window в поле Debug или меню View -> Disassembly Window (см. рис. 

). Кроме этого, при помощи отладчика можно просмотреть содержимое регистров, сло-
во-состояние микропроцессора и т.д. (окно 2 – окно проекта), а также просматривать пе-
ременные (окно 3 – окно переменных). 

23

 

 

 
 

Рис. 23. 
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При помощи меню Peripherals можно просматривать и вносить изменение в состоя-
ние интегрированной периферии микроконтроллера (см. рис 24), а использование Periph-
erals -> Reset CPU позволяет в любой момент перезапустить программу. 
 

В ходе выполнения лабораторной работы необходимо проделать вышеописанные 
операции. 

 
 

Рис. 24. 

Более подробное описание возможностей отладчика можно получить из руководства 
пользователя [1]. 

4.4 Проверка работоспособности учебно-лабораторного стенда SDK-1-1 
1. Изучить инструкцию по эксплуатации учебно-лабораторного стенда SDK-1-1 [3]. 
2. Ознакомиться с демонстрационной программой учебно-лабораторного стенда 

SDK-1-1 [6]. 
3. Запустить стенд в демонстрационном режиме. 
4. По результатам тестирования определить работоспособность стенда. 

4.5 Загрузка приложения в SDK-1-1 при помощи инструментальной сис-
темы T167B 
Предварительно перед выполнением загрузки приложения необходимо ознакомиться 

с руководством пользователя по программному обеспечению учебно-лабораторного стен-
да [3]. Далее необходимо выполнить следующие действия: 
1. Скопировать инструментальную систему T167B с диска 
L:\Study\МПТ\SDK_1_1\Utilities на свой диск U: в папку MPT, где она будет располагаться 
в ходе всего курса лабораторных работ. 
2. При помощи любого текстового редактора (например, FAR- менеджера) создать 
интерпретационный командный файл load.167 и сохранить его в директории проекта 
U:\MPT\LAB1\Hello.  
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Данный файл должен содержать инструкции среды T167B, например следующие: 
Пример 2. Пример инструкций среды T167B 

0x2100 0x0 addhexstart hello.hex 
1 12 openchannelrts 
0 term 
loadhex+ hello.hex 
0 term 
bye 

В соответствующих строках файла load.167 содержатся команды: 
1. Добавления адреса запуска приложения в hex- образ приложения (код про-

граммы в 16-ном формате с абсолютными адресами). 
2. Открытие последовательного интерфейса COM1 на скорости 9600 бит/с. 
3. Запуск эмулятора терминала в бинарном формате. 
4. Загрузка hex- образа в учебно-лабораторный стенд через открытый последо-

вательный интерфейс. После загрузки приложение автоматически запустится 
по добавленному адресу. 

5. Запуск эмулятора терминала в бинарном формате. 
6. Закрытие всех открытых каналов и выход из среды T167B. 

Для загрузки приложения прямо из Keil uVision необходимо выполнить следующие 
действия: 
1. При помощи меню Project -> Option for Target открыть окно параметров проекта и 
переключиться на закладку Utilities. В данном окне необходимо ввести настройки внеш-
ней утилиты программирования (в данном случае T167B): путь к программе и командную 
строку (см. рис. 25). При этом параметр Run independent должен быть обязательно вклю-
чен. 
 

 

 
 

Рис. 25. 
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2. При помощи меню Flash -> Download запустить среду T167B на выполнение ко-
мандного файла load.167 (см. рис. 26). После чего необходимо перезагрузить стенд (нажав 
на кнопку сброс). 
 

В результате чего должно появиться окно с приложением T167B (см. рис. 27). 

 
 

Рис. 26. 

 

При правильной работе должна появиться строка терминала: HEX202……….. 

 
 

Рис. 27. 
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3. Далее необходимо нажать клавишу Esc, что должно привести к выполнению сле-
дующей инструкции командного файла load.167, а именно loadhex+ (см. рис. 28). 
 

После загрузки, приложение должно запуститься (появятся бегущие огни на свето-
диодах стенда), а T167B – начать выполнять следующую команду, а именно 0 term, что 
приведёт к отображению строки “Hello Word”, которая передаётся по последовательному 
интерфейсу (см. рис. 29). 

 
 

Рис. 28. 

 

При следующем нажатие клавиши Esc окно должно закрыться (приложение T167B 
выгрузится). 

 
 

Рис. 29. 
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4.6 Возможные трудности при загрузке программы в SDK-1-1 
В пункте 2 не появляется строка HEX202…………… 
Возможные причины: учебно-лабораторный стенд подключен к COM2, а не к COM1. 
Методы устранения: в командном файле load.167 исправить строку открытия после-

довательного интерфейса на 2 12 openchannelrts, либо подключить стенд к COM1. 
В других случаях обратится к преподавателю. 
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5 Содержание отчёта 
Отчёт по лабораторной работе должен быть оформлен в соответствии с требования-

ми СТП ТПУ. Содержание отчёта: 
1. Цель работы. 
2. Цикл разработки приложения в Keil uVision (структурная схема с кратким описа-
нием). 
3. Основные этапы программирования учебно-лабораторного стенда SDK-1-1. 
4. Текст Вашей первой программы для SDK-1-1. 
3. Выводы по проделанной лабораторной работе. 
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Перечень источников 
1 Руководство пользователя интегрированной среды разработки Keil uVision 

L:\Keil\C51\HLP\gs51.pdf 
 
2. Руководство пользователя компилятора Cx51 

L:\Keil\C51\HLP\C51.pdf 
 
3 Учебный стенд SDK-1-1. Руководство пользователя 

L:\Study\МПТ\SDK_1_1\DOC\sdk11_userm_v1_0_7.pdf 
 
4 Руководство пользователя компилятора ассемблера Ax51 

L:\Keil\C51\HLP\A51.pdf 
 
5 Операционная система реального времени RTX51 

L:\Keil\C51\HLP\tr51.pdf 
 
6 SDK-1.1 Demonstration Set. Руководство пользователя. 

L:\Study\МПТ\SDK_1_1\DemoSet\doc\DemoSetUG.pdf 
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